An investigation of engineering properties of groundnut pods and kernels related to design the post-harvest machines

Hassan M. H. A.*, Geasa M. M.

Faculty of Agricultural Engineering, Al-Azhar University, Assiut 71524, Egypt

Abstract

The aim of this investigation is to study the main physical, mechanical and aerodynamic properties of groundnut pods and kernels (Giza 5 variety) at moisture content (8.2% db). Some engineering properties, such as size, weight, percentages of the pod parts, repose angle, coefficient of friction, rapture force, deformation distance, projected mean area, and terminal velocity were measured. The 3-Dimensional linear characteristics of the samples obtained from linear measurement led to the conclusion that groundnut (Giza 5 variety) is oblong shape. The average length, width, thickness, geometric mean diameter, sphericity, surface area and aspect ratio of groundnut contains one kernel were 25.15 mm, 18.03 mm, 16.01 mm, 19.28 mm, 77.62 %, 1176.2 mm², 73.16 % and hull thickness was 1.53 mm, respectively. For groundnut contains two kernels these characteristics were 38.62 mm, 16.17 mm, 14.91 mm, 21.23 mm, 55.38 %, 1423 mm², 43.82 % and hull thickness was 1.46 mm, respectively. While the groundnut contains three kernels were 45.63 mm, 15.71 mm, 14.57 mm, 21.84 mm, 48.05 %, 1502 mm², 34.64 % and hull thickness was 1.25 mm, respectively. The mean values of the weight percentages of pod parts to whole pod were 68.7 and 31.3 %, for kernels and hulls respectively. The average of repose angle and coefficient of friction of the groundnut pods and kernels were found to be 31.5°, 25.75°, and 0.36, 0.47, respectively. The rapture force of groundnut pods contain two kernels was higher than rapture force of groundnut pods contain three kernels and one kernel at horizontal position, it was 73.82 N. While the rapture force of groundnut pods contain one kernel was higher than rapture force of groundnut pods contain two kernels and three kernels at vertical position, it was 264.87 N. The deformation distance of groundnut pods contain one kernels was less than deformation distance of groundnut pods contain two kernels and three kernels at horizontal position, it was 2.4 mm. While the deformation distance of groundnut pods at vertical position increased when the kernels increased in pods. The mean values of terminal velocity were found 7.8, 8.1 and 7.9 m/s, respectively for pods which contain (one, two and three kernels). While the mean values of terminal velocity both kernel and hull were 7.52 and 4.06 m/s. Finally, the projected area of groundnut pods contain three kernels was higher than projected area of groundnut pods contain three kernels and one kernel it was 6.54 m², while, the mean value of projected area for kernels 1.76 m².

Keywords: groundnut kernels, rapture force, terminal velocity, projected area, shelling machine design.
1. Introduction

Groundnut (Arachis hypogaea L) or peanut is one of the important oil crops. It has several uses as whole seeds or is processed to make groundnut butter, oil, and other products (Putnam et al., 2013). It seeds contain 40–50% fat, 20–50% protein and 10–20% carbohydrate depending on the variety (Ondiege et al., 2010). The determination of the physical and mechanical properties of groundnut pods play an important role in problems associated with design, development and fabrication of harvesting, handling, processing (equipment or machineries), grading, cleaning, sorting, separation and packaging, sieve unit, a specific machine, handling, cleaning and storage (Mohsenin, 1980) and Alonge and Adigun (1999). Akcali et al. (2006) examined some physical properties of peanuts, which are effective in case of mobility or immobility. Firstly, the geometrical shape of peanuts and the specific mass and friction coefficient. A geometrical shape consisting of a cylinder and two hemispheres at the ends has found quantitative appropriateness of at most 91% and at least 34% for the varieties in Turkish standards. A variation of bulk density of hulled peanut were found 0.37–0.58 g/cm$^3$. The solid densities of kernel and shell were determined in the range of 0.88–0.93 g/cm$^3$ and 0.21–0.28 g/cm$^3$, respectively. The angle of repose and internal friction angle were measured around a 29°. The friction coefficient was found ranged from 0.23 for kernel on sheet metal up to 0.76 for hulled peanuts on an iron grate perpendicular to flow. Shukla et al. (2019) investigated the main physical and mechanical properties of groundnut pod (GG-20 variety). Some of the engineering properties, such as weight, size, shape, angle of repose, bulk density, equivalent diameter, sphericity, bulk density, angle of repose, coefficient of friction and terminal velocity. The average length, width and thickness of pods were found to be 27.86 mm, 13.78 mm and 12.06 mm, respectively. The average equivalent diameter was found to be 16.66 mm. The average sphericity was obtained as 0.55. The shape of groundnut pods comes under the category of oblong. The average bulk density groundnut pod was obtained as 0.286 g/cm$^3$. The average value of angle of repose of groundnut pod was observed as 24°. The average coefficient of friction of pods was found as 0.035. Mean terminal velocity of pods of GG-20 variety was found as 10.27 m/s. Maduako and Hamman (2004) determined some of the physical properties for three varieties of groundnuts namely ICGV-SM-93523, RMP-9 and RMP-12. The angle of repose for the three varieties was found to range from 27.5–29.50 for tire pods, 20.3–20.80 for the seeds and 33.7–36.00 for the shells. Coefficient of friction averaged 0.56 on wood and 0.41 on galvanized steel for the three varieties of groundnut pods. The moisture contents of the pods, seeds and shells were found to be 7.4%, 6.4% and 11.3% (wet basis) on the average respectively. The results also showed that groundnut pods and seeds were neither round nor spherical but may be oblong in shape. The mean values of the physical properties of the three varieties of groundnuts showed that
there were no significant varietal differences at \( p \leq 0.5 \) probability level. The implication of no significant varietal difference at \( p \leq 0.5 \) is that one machine can conveniently handle the shelling operation for the three varieties of groundnuts. Alonge and Adegbulugbe (2005) studied some physical properties of shelled and unshelled groundnuts. The mean values of major, minor and intermediate diameter (mutually perpendicular dimensions) were found to be 12.47, 7.21 and 7.78 mm for shelled seeds and 31.19, 10.74 and 10.80 mm for unshelled pods containing two to three seeds. The average sphericity and roundness were found to be 69.61% and 54.78% for shelled seeds and 50.17% and 42% for unshelled pods. The mean bulk density, porosity, kernel density, volume and angle of repose were found to be 0.60 g/cm\(^3\), 0.46, 1.11 g/cm\(^3\), 0.36 cm\(^3\) and 24.5 degrees respectively for shelled seeds and 0.21 g/cm\(^3\), 0.57 g/cm\(^3\), 0.49 g/cm\(^3\), 1.60 cm\(^3\) and 23.3 degrees for unshelled pods. Aydin (2007) evaluated some physical properties of peanut fruit and kernel as functions of moisture content. At the moisture content of 4.85% d.b. the average length, thickness, width, geometric mean diameter, sphericity, unit mass and volume of peanut fruits were 44.53 mm, 15.71 mm, 16.68 mm, 23.00 mm, 51.60%, 2.16 g and 5.17 cm\(^3\), respectively. Corresponding values for kernel at the moisture content of 6.00% d.b. were 20.95 mm, 8.80 mm, 10.44 mm, 12.60 mm, 57.05%, 1.063 g and 1.14 cm\(^3\), respectively. Re-wetted peanuts showed that the bulk density decreased from 243 to 184 kg/m\(^3\), the true density, projected area, and terminal velocity increased from 424 to 545 kg/m\(^3\), 4.88 to 6.85 cm\(^2\) and 7.25 to 7.93 m/s, respectively as the moisture content increased from 4.85% to 32.00% d.b.; for the kernel, the corresponding values changed from 581 to 539 kg/m\(^3\), 989 to 1088 kg/m\(^3\), 1.53 to 2.09 cm\(^3\) and 7.48 to 8.06 m/s, respectively as the moisture content increased. The rupture strength of peanut and kernel decreased as moisture content increased. The dynamic coefficient of friction varied from 0.30 to 0.73 for peanut, and from 0.22 to 0.63 for kernel over different structural surface as the moisture content increased from 4.85% to 32.00% d.b. Kurt and Arioglu (2018) analyzed for the physical and mechanical characteristics of five peanut cultivars (NC-V11, Halisbey, Arioglu 2003, Sultan and Osmaniye 2005) pods to select the most promising candidate. The results indicated that varied significant among the varieties. Shelling percentage values were varied between 65.7–71.6%. The highest shelling percentage was obtained at NC-V11 variety, while the lowest value was obtained at Sultan. The variety NC-V11, Halisbey, Arioglu 2003, Sultan and Osmaniye 2005 showed the average lengths of 42.27, 44.68, 46.17, 49.39 and 44.57 mm; width of 16.00, 17.90, 17.57, 17.45, and 17.92 mm; thickness of 17.33; 18.68; 18.54, 18.42, and 19.10 mm, respectively. Rupture force and stiffness values of peanuts depend on the cultivars and varied from 191.06 to 253.19 N and 129715.61 to 184954.67 N/m as higher
and lower values, respectively. The varieties Arioglu 2003, Halisbey and Sultan have lower rupture force and stiffness values. On the other hand, NC-V-11 and Osmaniye-2005 varieties have higher value of rupture force and stiffness. These findings indicated that these two varieties need to more energy for hull rupture. The NC-V-11 variety achieved the highest values of rupture force than others. Some varieties had thick and strong hull, while some other had thin and weak. El-Sayed et al. (2001) investigated and defined the physical and aerodynamic properties of peanut (Arachis hypogaea L.) pods. The geometric diameter, mass, and standard deviation values of three peanut varieties (American, Chinese, and Egyptian) had no significant differences. The terminal velocity for different varieties of pods ranged between 7.7 to 12.9 m/s. Experimental measurements of shelled components of the Egyptian variety (Gisa-5) indicated that the terminal velocity value of 7.4 m/s was optimal for airflow velocity to separate shelled peanut components from the shells with only 1.8% loss of intactness and split seeds on a sieved surface of 6.3 and 8.0 mm. Also importantly, air velocity values of 10.2 and 9.8 m/s were found adequate to separate the intact seeds from the split seeds when they are sieved on surfaces with meshes of 8.0 and 6.3 mm, respectively. Uyeri and Uguru (2018) investigated some compressive resistance (force, energy and deformation at rupture point) of two groundnut varieties (SAMNUT 10 and SAMNUT 11) kernels in terms of kernel sizes. The groundnut kernels were loaded quasi-statically in the axial orientation at a compressive loading rate of 20 mm/min, using the Universal Testing Machine. Results showed that kernel size and groundnut variety had significant (P≤0.05) effect on all the mechanical parameters studied. The force required for initiating the kernel rupture increased from 37.21 to 76.10 N for SAMNUT 10 and 30.10 to 64.19 N for SAMNUT 11, as the kernels size increased from small to large size. In addition, the energy absorbed by the kernel at rupture point increased from 0.021 to 0.054 Nm for SAMNUT 10, and 0.016 to 0.044 Nm for SAMNUT 11, for the small and large kernel sizes respectively. Furthermore, the results showed that SAMNUT 10 kernels had slightly higher compressive resistance values than the SAMNUT 11 kernels. Bagheri et al. (2011) measured some physical properties of four varieties of peanut (pod and kernel) at initial moisture content. Afterwards, the required force for initial rupturing of the peanut kernels under compression loading was determined as a function of kernel moisture content (between 7 and 35% w.b.) and compression load direction. The compression load was applied laterally containing the suture line (direction 1), perpendicular to direction 1 (direction 2) and longitudinally through the hilum (direction 3). Results showed that Iraqi 1 variety had the highest value of rupture force for both kernel and pod. Also, was a strongly polynomial relationship between rupture force and kernel moisture content for whole tested varieties. The average values of the rupture force at direction 2 were 61, 60,
64 and 57% higher than direction 3 for Goli, Valencia, Iraqi 1 and Iraqi 2 varieties, respectively. Considering peanut kernels, the rapture force required to initiate rupturing was less at direction 3 than directions 1 and 2, therefore it is proposed that cracking operation should be performed along this direction. Ince et al. (2009) examined the rupture resistance of both hulled peanut and its kernel in terms of average rupture force, deformation, firmness and toughness. Samples at various moisture contents and sizes were compressed at three loading positions (longitudinal, parallel to split plane and perpendicular to split plane). The compressive force needed to rupture for the hulled peanut and the kernel decreased with an increase in moisture content as the deformation at rupture point increased. Moreover, firmness increased, and toughness decreased when moisture content increased. Larger size hulled peanut and kernel had higher rupture force and firmness values. For toughness, the trend was opposite. The highest values of firmness and toughness were measured at perpendicular loading position to the split plane. The overall average values of rupture force, deformation, firmness and toughness for hulled peanut and kernel when the samples were compressed, in relation to the overall range of moisture content, size and loading position, were determined as 87.58 and 47.45 N, 2.16 and 1.46 mm, 46.80 and 49.40 N/mm, 0.018 and 0.024 mJ/ mm³, respectively. Kumari and Narinder (2015) reported that given the ease of detecting different dimensions of objects, such as size, shape, and color (RGB) analysis, digital image processing is increasingly being employed in numerous industries, including food processing. Image processing may be described in the form of multidimensional systems, which is a key characteristic. Image processing has become the cheapest option due to the development of many high-speed computers and signal processors. They added that image analysis is one of the best methods for measuring powder size distribution. And ImageJ software, which is freeware Java based Image Processing software has been used.

2. Materials and methods

2.1 Sampling

Engineering and aerodynamics properties of groundnut pods and kernels of variety (Giza-5) were measured and evaluated at Faculty of Agricultural Engineering, Al-Azhar University, Assuit, Egypt. Moisture content was 8.2 % (db).

2.2 Determination of size

The size of groundnut pods and kernels was determined in terms of length (L), width (W) and thickness (T). One hundred groundnut pods and kernels were taken and measured the dimensions L, W and T (Figure 1) with using Vernier Caliper with accuracy 0.05 mm. Size of each pod and kernels in terms of geometric mean diameter (Dg), surface area (Sa), sphericity (Φ) and aspect ratio (Ra) were determined by using following formulas (Mohsenin, 1986):

\[ Dg = (L \times W \times T)^{1/3}, \text{mm} \]

\[ \text{Surface area (Sa)} = \pi (Dg)^2, \text{mm}^2 \]
Sphericity (S) = (Dg/L)*100, %  
Aspect ratio (Ra) = (W/L)*100, %

2.3 Determination of average weight of the groundnut pods and kernels

A sample of 100 groundnut pods and kernels was selected randomly to determine the average weight, using a digital balance with the accuracy of 0.01 g.

2.4 Percentages of the pod parts

The kernels were manually separated and weighed to determine the percentage of parts (%, by wt.) from kernels and hulls to pod as shown in the following equations:

Kernels (%) = (Mass of kernel / Mass of pod) × 100

Hulls (%) = (Mass of Hull / Mass of pod) × 100

2.5 Angle of repose, (θ)

This is the angle between the horizontal base and the inclined side of the formed cone due to free fall of hulls sample. The horizontal base of the cone (x) and its height (h) were measured. Three replicated trials were conducted for pods and kernels. The repose angle can be calculated as follows (Mohsenin, 1986):

θ = \tan^{-1}(2h/x)

2.6 Coefficient of friction

The method of inclined plane apparatus was used to determine the coefficient of static friction for galvanized steel surface. The table gently raised and the angle of inclination to the horizontal at which the sample starts to slide was read off from the protractor attached to the apparatus. The tangent of the angle was reported as the coefficient of static friction. The following equation was used to calculate the coefficient of friction and angle of internal friction for the groundnut pods and kernels (Mohsenin, 1986):

μ = \tan\theta

Figure (1): Axis and three major perpendicular dimensions of peanut.
Where, $\mu = \text{the coefficient of friction}$, $\emptyset = \text{the angle of internal friction}$.

2.7 Determination of shape of the groundnut pods and kernels

The shape of groundnut pods and kernels was determined using the following formula which explained by Abd Alla et al. (1995). It was suggested that the value of index-$K >1.5$, then the grain is observed oblong, and the value of index-$K \leq 1.5$ the grain is observed spherical. The average values of the length, width, and thickness of the groundnut pods and kernels were placed in the next equation, and the values of index-$K$ for groundnut pods and kernels were found to be 2.93 and 2.07, respectively.

Index-$K = \frac{L}{(W^*T)^{1/2}}$

2.8 The mechanical behavior of groundnut pods

It was expressed in terms of force required to rupture the pod sample, deformation at rupture point, the deformation ratio, the hardness and energy absorbed. The rupture force of pod sample was determined by using a digital universal material tester. The specifications of device were as follows: Model No: MT 20 21, range of the measurement is 0 to 20000 N and its accuracy is 0.1 N as shown in Figure (2).

![Universal Material Tester](image)

Figure (2): Universal Material Tester

Rupture force (FR, N) is the minimum force required for crack the pit. Deformation (d, mm) at rupture point in loading direction. The used sample for measure the rupture force was 48 pods. This sample was divided to three groups (pod contains one kernel, pod contains two kernels and pod contains three kernels). The number of pods were 16 pods/group. The rupture force was measured at two axial dimensions (length and width) of pods as shown in Figure (3). The data obtained were subjected to descriptive statistics such as; range (minimum “Min” and maximum “Max”), mean, standard deviation (SD) and
coefficient of variation (CV).

2.9 Terminal velocity apparatus

The terminal velocity apparatus (Figure 4) was fabricated in the Faculty of Agricultural Engineering, Al-Azhar University, Assuit, Egypt, according to Saracoglu and Ozarslan (2012). A device consists of a vertical transparent plastic tube 110 cm long with a diameter of 60 mm, which was used to suspend the particles in an air stream. This tube fixed in another rigged 60 cm long tube containing an air-flow straightener to improve air flow uniformity throw transparent tube. The air was supplied by a blower fan powered by an electric motor. To manage the airflow rate, speed of blower motor was controlled by electronic dimmer. In the beginning, the blower output was set at minimum. For each experiment, a sample was dropped into the air stream from the top of the air column. Then airflow rate was gradually increased till the pod mass gets suspended in the air stream. Three digits were recorded in each experiment when the pod suspend in the vertical air stream, transparent tube outlet air velocity - distance from the bottom of transparent tube to flowed pod position after that the transparent tube removed to record inlet air velocity. The value of the terminal velocity \( T_v \) “m/s” was calculated using the following equation:

\[
T_v = I_s - \left( \frac{F_d}{T_l} \right) \times (I_s - O_s)
\]

Where:
- \( T_v \): Air terminal velocity (m/s),
- \( I_s \): transparent tube inlet air velocity (m/s),
- \( F_d \): distance from bottom of transparent tube to flowed pod position (cm),
- \( T_l \): long of vertical transparent plastic tube (110 cm) and \( O_s \): transparent tube outlet air velocity (m/s).

Five replications for each groundnut sample were made. Digital anemometer extech model AN100 with accuracy 0.01 m/s was used to determine air velocity.

(a) Longitudinally position.  (b) Vertically position.

Figure (3): The groundnut pods under universal material tester.
2.10 Pods projected area

The projected area of pods (contain one kernel, two kernels and three kernels) were measured by Image Analysis which is one of the best methods for measuring irregular shapes like most of agriculture products size. ImageJ software, which is freeware Java based Image Processing software, has been used in this paper for peanut pods projected area analysis. After take pictures to pods samples on dark background with Vernier caliper with high resolution, the file opened In ImageJ software, and choose the following steps:

1- Analyze > Set Scale, was chosen and information entered to showed that 1 pixel represents a known distance as shown in Figure (5).
2- Image > Type > 8-bit, was chosen to convert the image to grayscale.
3- Image > Adjust > Threshold, was chosen to show the Threshold dialog window to allows turn pods color to red, finally to measure the area.
4- Analyze > Set Measurements and click the Area and Limit to Threshold checkboxes.
5- Analyze > Measure, was chosen to measure the area of pods as shown in Figure (6).
3. Results and Discussion

3.1 Physical properties of groundnut pods and kernels

The measuring of physical properties of groundnut pods and kernels are given in Table (1). For pod contains one kernel, the average length, width, and thickness were measured as 25.15, 18.03 and 16.01 mm. Pod contains two kernels, the average length, width, and thickness were measured as 38.62, 16.77 and 14.91 mm. Pod contain three kernels, the average length, width, and thickness were measured as 45.63, 15.71 and 14.57 mm respectively. The average length, width, and thickness of kernels were measured as 20.29, 10.24 and 9.42 mm while the average value of hull thickness
was 1.41 mm for Giza-5 variety of groundnuts. These measured dimensions will be important for designing of hopper, the opening of the concave, crushing drum, and clearance between drum and concave unit as described by Maduako and Hamman (2004). The mean geometric diameter, surface area, sphericity, and aspect ratio of groundnut pods contain one kernel were found to be 19.28 mm, 1176.2 mm², 77.62% and 73.16% respectively. Groundnut pods contain two kernels the mean geometric diameter, surface area, sphericity, and aspect ratio were found to be 21.23 mm, 1423.1 mm², 55.38% and 43.82% respectively. While, the mean geometric diameter, surface area, sphericity, and aspect ratio of groundnut pods contain three kernels were found to be 21.84 mm, 1502 mm², 48.05% and 34.64% respectively. For kernels, the mean geometric diameter, surface area, sphericity, and aspect ratio were found to be 12.51 mm, 491.13 mm², 61.64% and 50.47% respectively. The average value of sphericity of kernels was observed higher than the pods, which means the sliding ability of kernels is higher than the pods.

3.2 Average of weight of groundnut pod parts and its percentages

The average weight of groundnut pods, kernels and hulls are given in Table (2). The average weight of groundnut pods contain one kernel, two kernels and three kernels were measured as 1.67, 2.4 and 2.51 g, respectively. While, the average weights of kernels for pod contain one kernel, pod contain two kernels and pod contains three kernels were 1.19, 1.74

Table (1): Some physical properties of pods, kernels and hulls of groundnut.

<table>
<thead>
<tr>
<th>Pod contains</th>
<th>Properties</th>
<th>Mean</th>
<th>Max</th>
<th>Min</th>
<th>SD</th>
<th>CV</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pod contains one kernel</td>
<td>Length, mm</td>
<td>25.15</td>
<td>31.5</td>
<td>17.4</td>
<td>0.3876</td>
<td>0.1541</td>
</tr>
<tr>
<td></td>
<td>Width, mm</td>
<td>18.03</td>
<td>26</td>
<td>15.2</td>
<td>0.3102</td>
<td>0.172</td>
</tr>
<tr>
<td></td>
<td>Thickness, mm</td>
<td>16.01</td>
<td>17.5</td>
<td>14.4</td>
<td>0.1012</td>
<td>0.0632</td>
</tr>
<tr>
<td></td>
<td>Dg, mm</td>
<td>19.28</td>
<td>22.257</td>
<td>16.452</td>
<td>0.1787</td>
<td>0.0927</td>
</tr>
<tr>
<td></td>
<td>Sph, %</td>
<td>77.624</td>
<td>94.55</td>
<td>70.33</td>
<td>8.4179</td>
<td>0.1084</td>
</tr>
<tr>
<td></td>
<td>Sa, mm²</td>
<td>1176.2</td>
<td>1555.4</td>
<td>849.87</td>
<td>2.1764</td>
<td>0.185</td>
</tr>
<tr>
<td></td>
<td>Ra, %</td>
<td>73.159</td>
<td>111.59</td>
<td>59.925</td>
<td>16.79</td>
<td>0.2295</td>
</tr>
<tr>
<td></td>
<td>Hull thickness, mm</td>
<td>1.53</td>
<td>2.5</td>
<td>1</td>
<td>0.4347</td>
<td>0.2841</td>
</tr>
<tr>
<td>Pod contains two kernels</td>
<td>Length, mm</td>
<td>38.62</td>
<td>46.8</td>
<td>30.6</td>
<td>0.4385</td>
<td>0.1135</td>
</tr>
<tr>
<td></td>
<td>Width, mm</td>
<td>16.77</td>
<td>18.8</td>
<td>14.6</td>
<td>0.147</td>
<td>0.0876</td>
</tr>
<tr>
<td></td>
<td>Thickness, mm</td>
<td>14.91</td>
<td>17.7</td>
<td>11.7</td>
<td>0.1819</td>
<td>0.122</td>
</tr>
<tr>
<td></td>
<td>Dg, mm</td>
<td>21.234</td>
<td>23.416</td>
<td>19.033</td>
<td>0.161</td>
<td>0.0758</td>
</tr>
<tr>
<td></td>
<td>Sph, %</td>
<td>55.383</td>
<td>66.228</td>
<td>49.909</td>
<td>5.2852</td>
<td>0.0954</td>
</tr>
<tr>
<td></td>
<td>Sa, mm²</td>
<td>1423.1</td>
<td>1721.7</td>
<td>1137.4</td>
<td>2.1623</td>
<td>0.1519</td>
</tr>
<tr>
<td></td>
<td>Ra, %</td>
<td>43.821</td>
<td>55.556</td>
<td>37.629</td>
<td>5.4959</td>
<td>0.1254</td>
</tr>
<tr>
<td></td>
<td>Hull thickness, mm</td>
<td>1.46</td>
<td>2.3</td>
<td>1</td>
<td>0.3748</td>
<td>0.2567</td>
</tr>
<tr>
<td>Pod contains three kernels</td>
<td>Length, mm</td>
<td>45.63</td>
<td>52.4</td>
<td>38.3</td>
<td>0.4233</td>
<td>0.0928</td>
</tr>
<tr>
<td></td>
<td>Width, mm</td>
<td>15.71</td>
<td>17.7</td>
<td>14.6</td>
<td>0.1006</td>
<td>0.064</td>
</tr>
<tr>
<td></td>
<td>Thickness, mm</td>
<td>14.57</td>
<td>15.5</td>
<td>13.4</td>
<td>0.0918</td>
<td>0.063</td>
</tr>
<tr>
<td></td>
<td>Dg, mm</td>
<td>21.838</td>
<td>23.797</td>
<td>19.568</td>
<td>0.1278</td>
<td>0.0585</td>
</tr>
<tr>
<td></td>
<td>Sph, %</td>
<td>48.051</td>
<td>53.108</td>
<td>45.06</td>
<td>2.8876</td>
<td>0.0601</td>
</tr>
<tr>
<td></td>
<td>Sa, mm²</td>
<td>1502</td>
<td>1792.2</td>
<td>1202.4</td>
<td>1.7451</td>
<td>0.1182</td>
</tr>
<tr>
<td></td>
<td>Ra, %</td>
<td>34.643</td>
<td>39.454</td>
<td>30.247</td>
<td>2.8225</td>
<td>0.0948</td>
</tr>
<tr>
<td></td>
<td>Hull thickness, mm</td>
<td>1.25</td>
<td>1.4</td>
<td>1</td>
<td>0.1716</td>
<td>0.1373</td>
</tr>
<tr>
<td>Kernel only</td>
<td>Length, mm</td>
<td>20.29</td>
<td>23.4</td>
<td>15.85</td>
<td>0.2514</td>
<td>0.1239</td>
</tr>
<tr>
<td></td>
<td>Width, mm</td>
<td>10.24</td>
<td>11.7</td>
<td>8.3</td>
<td>0.0885</td>
<td>0.0664</td>
</tr>
<tr>
<td></td>
<td>Thickness, mm</td>
<td>9.415</td>
<td>10.6</td>
<td>8.3</td>
<td>0.0788</td>
<td>0.0805</td>
</tr>
<tr>
<td></td>
<td>Dg, mm</td>
<td>12.506</td>
<td>14.264</td>
<td>10.772</td>
<td>0.0764</td>
<td>0.0611</td>
</tr>
<tr>
<td></td>
<td>Sph, %</td>
<td>61.639</td>
<td>60.956</td>
<td>51.306</td>
<td>6.4999</td>
<td>0.1053</td>
</tr>
<tr>
<td></td>
<td>Sa, mm²</td>
<td>491.13</td>
<td>638.85</td>
<td>364.32</td>
<td>0.5816</td>
<td>0.1184</td>
</tr>
<tr>
<td></td>
<td>Ra, %</td>
<td>50.448</td>
<td>50</td>
<td>37.179</td>
<td>7.9494</td>
<td>0.1582</td>
</tr>
</tbody>
</table>
and 1.79 gm. One the other hands, the average weights of hulls for pod contain one kernel, pod contain two kernels and pod contains three kernels were 0.48, 0.66 and 0.71 gm. The average weight of groundnut pods and kernels will be used to decide the size and capacity of hopper and crushing chamber that provide the stability of the machine during operation. While the average weight of groundnut hulls will be used to determinate fan speed for separation operation.

Table (2): The average weight of pods, kernels and hulls of groundnut.

<table>
<thead>
<tr>
<th>Pod contains</th>
<th>Mean</th>
<th>Maximum</th>
<th>Minimum</th>
<th>SD</th>
<th>CV</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pod contains one kernel</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pod</td>
<td>1.67</td>
<td>2.19</td>
<td>1.35</td>
<td>0.26034</td>
<td>0.15589</td>
</tr>
<tr>
<td>Kernel</td>
<td>1.188</td>
<td>1.52</td>
<td>0.9</td>
<td>0.18624</td>
<td>0.15677</td>
</tr>
<tr>
<td>Hull</td>
<td>0.475</td>
<td>0.67</td>
<td>0.35</td>
<td>0.10916</td>
<td>0.22982</td>
</tr>
<tr>
<td>Pod contains two kernels</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pod</td>
<td>2.401</td>
<td>3.28</td>
<td>1.74</td>
<td>0.47795</td>
<td>0.19906</td>
</tr>
<tr>
<td>Kernel</td>
<td>1.741</td>
<td>2.36</td>
<td>1.24</td>
<td>0.36656</td>
<td>0.21055</td>
</tr>
<tr>
<td>Hull</td>
<td>0.661</td>
<td>0.9</td>
<td>0.49</td>
<td>0.13812</td>
<td>0.20895</td>
</tr>
<tr>
<td>Pod contains three kernels</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pod</td>
<td>2.505</td>
<td>3.9</td>
<td>1.28</td>
<td>0.79633</td>
<td>0.3179</td>
</tr>
<tr>
<td>Kernel</td>
<td>1.792</td>
<td>2.85</td>
<td>0.65</td>
<td>0.70222</td>
<td>0.39186</td>
</tr>
<tr>
<td>Hull</td>
<td>0.705</td>
<td>1.04</td>
<td>0.51</td>
<td>0.16298</td>
<td>0.23117</td>
</tr>
</tbody>
</table>

Table (3) shows the values of total groundnut pod parts to whole pod (%). Percentage of kernels and hulls ranged from 50.78 to 73.08 and 26.92 to 49.2% and the mean values were 68.7 and 31.3%, respectively. These results may help for determining the mass of kernels in pods using the following equation:

\[
M_k = 0.687 M_p
\]

\[
M_H = 0.313 M_p
\]

Table (3): Percentages of average pod parts.

<table>
<thead>
<tr>
<th>Pod parts</th>
<th>Average</th>
<th>Maximum</th>
<th>Minimum</th>
<th>SD</th>
<th>CV</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kernels (%)</td>
<td>68.70</td>
<td>73.07</td>
<td>50.78</td>
<td>6.98</td>
<td>0.10</td>
</tr>
<tr>
<td>Hulls (%)</td>
<td>31.29</td>
<td>49.21</td>
<td>26.92</td>
<td>6.98</td>
<td>0.22</td>
</tr>
</tbody>
</table>

3.3 Mechanical behavior of groundnut pods and kernels

3.3.1 Repose angle and coefficient of friction

The repose angle average and coefficient of friction for pods and kernels are given in Table (4). The average of repose angle and coefficient of friction of the groundnut pods and kernels were found to be 31.5°, 25.75°, and 0.36, 0.47, respectively. It was observed that the angle of repose for groundnut pods was more than the kernels, and this may be due to the irregular and roughness surface of the groundnut pods. The conical structure of groundnut pods was raised by stick the pods one another, and it made a larger angle than kernels. The static coefficient of groundnut pods and kernels is needful in designing storage bins, pneumatic conveyor systems, screw conveyors, and threshing (Sahay and Singh, 2003). These measured physical properties of groundnut pods and kernels may be slightly divertive from the other physical properties of groundnut pods.
and kernels explained by Muhammad et al. (2015) and Odesanya et al. (2015).

<table>
<thead>
<tr>
<th>Type</th>
<th>Average</th>
<th>Maximum</th>
<th>Minimum</th>
<th>SD</th>
<th>CV</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pod</td>
<td>Φ</td>
<td>0.36</td>
<td>0.38</td>
<td>0.35</td>
<td>0.011</td>
</tr>
<tr>
<td></td>
<td>θ°</td>
<td>31.5</td>
<td>34</td>
<td>29</td>
<td>1.9539</td>
</tr>
<tr>
<td>Kernel</td>
<td>Φ</td>
<td>0.47</td>
<td>0.53</td>
<td>0.36</td>
<td>0.0717</td>
</tr>
<tr>
<td></td>
<td>θ°</td>
<td>25.75</td>
<td>28</td>
<td>24</td>
<td>1.7078</td>
</tr>
</tbody>
</table>

### 3.3.2 Rupture force and deformation distance

Table (5) shows that the mean, maximum and minimum values of the rupture force and the deformation distance at horizontal and vertical axial dimensions of the groundnut pods which contains (one kernel, two kernels and three kernels). For groundnut contains one kernel the results showed that the rupture force ranged from 18.64 to 71.61 N, and 88.29 to 264.87 N with mean value of 43.41 and 188.84 N at horizontal and vertical positions of groundnut pods, respectively. For groundnut contains two kernels the results showed that the rupture force ranged from 61.8 to 106.93 N, and 11.77 to 76.52 N with mean value of 73.82 and 33.97 N at horizontal and vertical positions of groundnut pods, respectively. For groundnut contains three kernels the results showed that the rupture force ranged from 65.73 to 80.44 N, and 10.79 to 49.05 N with mean value of 70.44 and 29.76 N at horizontal and vertical positions of groundnut pods, respectively. The results indicated that the rupture force of groundnut pods contain one kernel was higher than rupture force of groundnut pods contain two kernels and three kernels at horizontal position. The rupture force of groundnut pods contain one kernel were ranged from 1.93 to 2.95 mm, and 2.19 to 6.05 mm with mean value of 2.4 and 4.45 mm at horizontal and vertical positions of groundnut pods, respectively. For groundnut contains two kernels the results showed that the deformation distance ranged from 1.49 to 6.27 mm, and 4.25 to 6.47 mm with mean value of 3.25 and 5.44 mm at horizontal and vertical positions of groundnut pods, respectively. For groundnut contains three kernels the results showed that the deformation distance ranged from 2.49 to 5.03 mm, and 4.94 to 12.93 mm with mean value of 3.2 and 9.58 mm at horizontal and vertical positions of groundnut pods, respectively. The results indicated that the deformation distance of groundnut pods contain one kernel was less than deformation distance of groundnut pods contain two kernels and three kernels at horizontal position. While the deformation distance of groundnut pods at vertical position increased when the kernels increased in pods.
Table (5): Rupture force and deformation distance of groundnut pods with different loading orientation.

<table>
<thead>
<tr>
<th>Pod contains</th>
<th>Position</th>
<th>Rupture Force, N</th>
<th>Minimum</th>
<th>Maximum</th>
<th>Mean</th>
<th>SD</th>
<th>CV</th>
</tr>
</thead>
<tbody>
<tr>
<td>One Kernel</td>
<td>Horizontal</td>
<td>71.613</td>
<td>18.639</td>
<td>43.40925</td>
<td>22.8551</td>
<td>0.526503</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Deformation, mm</td>
<td>2.95</td>
<td>1.93</td>
<td>2.4</td>
<td>0.418774</td>
<td>0.174489</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vertical</td>
<td>264.87</td>
<td>88.29</td>
<td>188.8425</td>
<td>64.59506</td>
<td>0.342058</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Deformation, mm</td>
<td>6.05</td>
<td>2.19</td>
<td>4.45375</td>
<td>1.537279</td>
<td>0.345165</td>
<td></td>
</tr>
<tr>
<td>Two kernels</td>
<td>Horizontal</td>
<td>106.929</td>
<td>61.803</td>
<td>73.82025</td>
<td>14.1263</td>
<td>0.191361</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Deformation, mm</td>
<td>6.27</td>
<td>1.49</td>
<td>3.25375</td>
<td>1.566351</td>
<td>0.481399</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vertical</td>
<td>76.518</td>
<td>11.772</td>
<td>33.96713</td>
<td>20.03559</td>
<td>0.589852</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Deformation, mm</td>
<td>6.47</td>
<td>4.25</td>
<td>5.44</td>
<td>0.860166</td>
<td>0.158119</td>
<td></td>
</tr>
<tr>
<td>Three kernels</td>
<td>Horizontal</td>
<td>80.442</td>
<td>65.727</td>
<td>70.4358</td>
<td>5.902327</td>
<td>0.083797</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Deformation, mm</td>
<td>5.03</td>
<td>2.49</td>
<td>3.2</td>
<td>1.066349</td>
<td>0.333234</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vertical</td>
<td>49.05</td>
<td>10.791</td>
<td>29.757</td>
<td>15.16801</td>
<td>0.509729</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Deformation, mm</td>
<td>12.93</td>
<td>4.94</td>
<td>9.578333</td>
<td>3.486164</td>
<td>0.363963</td>
<td></td>
</tr>
</tbody>
</table>

3.4 Aerodynamic properties

3.4.1 Terminal velocities of pods, kernels and hulls

The terminal velocities required for suspending the pods, kernels and hulls depicted in Figure (7). The corresponding mean values were found to be 7.8, 8.1 and 7.9 m/s, respectively for pods which contain (one, two and three kernels).

While, the mean values of terminal velocity both kernel and hull were 7.52 and 4.06 m/s. As expected, the terminal velocity of the hull was lower than for the pod and kernel. The significant difference between the suspension air velocities for the kernel and hull indicate that separation of these fractions by pneumatic means is feasible. The data on terminal velocity can be used in designing an aspiration unit.
3.3.2 Projected areas of pods and kernels

Table (6) shows that the mean, maximum and minimum values of the projected areas of the groundnut pods which contains (one kernel, two kernels and three kernels) and kernels. For groundnut contains one kernel the results showed that the projected areas ranged from 2.78 to 4.44 cm², with mean value of 3.59 cm², respectively. The results of pods contain two kernels showed that the projected areas ranged from 4.92 to 8.65 cm², with mean value of 6.04 cm², respectively. While, pods which contain three kernels the results showed that the projected areas ranged from 4.91 to 10.13 cm², with mean value of 6.65 cm², respectively. Furthermore, the projected areas of average kernels ranged from 1.4 to 2.2 cm², with mean value of 1.76 cm², respectively. The results indicated that the projected area of groundnut pods contain three kernels was higher than projected area of groundnut pods contain three kernels and one kernel.

Table (6): Projected areas of pods and kernels.

<table>
<thead>
<tr>
<th>Pods and kernels</th>
<th>Mean</th>
<th>Minimum</th>
<th>Maximum</th>
<th>SD</th>
<th>CV</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pod contains</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>One kernel</td>
<td>3.5918</td>
<td>2.874</td>
<td>4.439</td>
<td>0.47189</td>
<td>0.13138</td>
</tr>
<tr>
<td>Two kernels</td>
<td>6.041</td>
<td>4.924</td>
<td>8.646</td>
<td>1.141365</td>
<td>0.188936</td>
</tr>
<tr>
<td>Three kernels</td>
<td>6.5486</td>
<td>4.908</td>
<td>10.126</td>
<td>1.634364</td>
<td>0.249575</td>
</tr>
<tr>
<td>Kernels</td>
<td>1.76</td>
<td>1.4</td>
<td>2.2</td>
<td>0.263312</td>
<td>0.149609</td>
</tr>
</tbody>
</table>

4. Conclusion

The physical, mechanical and aerodynamic properties of groundnut pods and kernels are fundamental parameters that provide a brief knowledge and useful to design the agriculture machine in harvesting, threshing, shelling, and post-harvest processing operation. These mechanical properties of groundnut pods at different loading orientations are important in designing of milling, handling, storage, and transportation unit. The following conclusions are drawn from the study of the some physical, mechanical and aerodynamic properties of groundnut pods and kernels (Giza 5 variety) at moisture content (8.2 % db):

1- The average length, width, thickness, geometric mean diameter, sphericity, surface area and aspect ratio of groundnut pods (contains one, two and three kernels) and kernels were all investigated and reported.

2- The results obtained indicated that the weight percentages of pod parts to whole pod were 68.7 and 31.3 %, for kernels and hulls respectively.

3- The average of repose angle and coefficient of friction of the groundnut pods and kernels were found to be 31.5°, 25.75°, and 0.36, 0.47, respectively.

4- The rapture force of groundnut pods contain two kernels was higher than other groundnut pods at horizontal position, while the rapture force of groundnut pods contain one kernel was higher than rapture force of
groundnut pods contain two kernels and three kernels at vertical position.

5- The terminal velocity was found 7.8, 8.1 and 7.9 m/s, respectively for pods which contain (one, two and three kernels). While, the terminal velocity both kernel and hull were 7.52 and 4.06 m/s.

6- The projected area of groundnut pods contain three kernels was highest value. It was 4.91 cm$^2$. While, the mean value of projected area for pods contain one kernel was 2.9 cm$^2$.

References


